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Service Technologies Corporation makes no representations or warranties with respect to the contents of this guide and disclaims any implied warranties of fitness for any particular purpose.  We reserve the right to revise this publication.  No part of this publication may be reproduced in any form without the prior written consent of Service Technologies Corporation.

Trademark Acknowledgments:  Platinum for DOS® is a registered trademark of E Software Corporation. Pay-Ware is a registered trademark of Service Technologies Corp.   Platinum is a registered trademark of Platinum Technologies Int’l Inc.  & Best Software Corp.  All other trademarks are acknowledged.

Contact Information on Service Technologies Corp.

We value our customer relationships and take pride in being a responsive Software Developer.  Since we never stop refining our products, our user partners (you) are a key source of desired new product features as well as occasionally finding the odd “glitch” in our software (there is no such thing as a perfect program - ask Bill Gates about Windows 95 ‘er 98 ‘er 98se ‘er 2000).




We enjoy hearing from you and here’s how you can contact us.
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Phone 






       
(336) 768-1787 




       (“Live Bodies” generally available 8AM - 5:30 PM Eastern Mon-Fri)

Fax 





 


(336) 768-1602












E- mail



            

support@pay-ware.com

Thanks for purchasing a Service Technologies’ Windows Program. 

Our Programs have been designed to provide Accounting Users with immediate comfort though easy-to-use, familiar Menu Architecture & Processing Logic.  Further, STC Programs come with 30 days of unlimited support.  So, if after reading the enclosed materials you have additional questions, please contact us.

IMPORTANT SERVICE TECHNOLOGIES SOFTWARE LICENSE AGREEMENT  - -  

READ CAREFULLY BEFORE OPENING SOFTWARE

This is a legal agreement between you (an individual or an entity) the end user, and Service Technologies Corporation (STC).  If you do not agree to the terms of this Agreement, promptly return the unopened cd package and all accompanying written materials to the place obtained for a refund.

1. GRANT OF LICENSE.  This STC license agreement (“license”) permits you to use one copy of the STC software product (“software”) on any single computer, provided the software is “in use” on only one computer at any time.  You may have as many copies of the software in use as you have licenses.

The software is “in use” in a computer when it is loaded into the temporary memory (i.e. RAM) or is installed into the permanent memory (e.g. Hard disk, or other storage device) of that computer; however a copy installed on a network server for the sole purpose of distribution to other computers is not “in use.”

You must have a reasonable mechanism in place to assure that the number of persons using the software concurrently does not exceed the number of licenses.  If the software is permanently installed on the storage device of a computer (other than a network server), then the person authorized to use such computer may also use the software on a portable computer or home computer.  If such person’s authorization to use such computer ceases for any reason, then such person’s authority to use the software on the portable or home computer shall cease.

2. COPYRIGHT.  The software is owned by STC or its suppliers and is protected by United States copyright laws.  Therefore you must treat the software like any copyrighted material (e.g. a book or musical recording) except that you may either (a) make one copy of the software for backup or archival purposes, or (b) transfer the software to a single hard disk provided you keep the original solely for backup or archival purposes.  You may not copy written material accompanying the software.

3. OTHER RESTRICTIONS. You may not rent or lease the software, but you may transfer your rights under this license on a permanent basis provided you retain no copies and the recipient agrees to the terms of this license.   Any transfer must include the most recent update and all prior versions.   You may not reverse engineer, decompile or disassemble the software.

4.  LIMITED WARRANTY.  STC programs are provided “as is” without any expressed or implied warranty of any kind, except that the disk will boot up within 90 days of purchase.  The entire risk as to the quality and performance of the programs is with you, the licensee.  Should the programs prove defective, you assume the risk and liability for the entire cost of all necessary repair, service or correction.  Some states do not allow the exclusion of implied warranties, so the above limitations may not apply to you.  This warranty gives you specific legal rights, and you may have other rights which vary from state to state as well. 

 5. LIMITATION OF REMEDIES.  STC’s entire liability and your exclusive remedy shall be replacement of any non-bootable cd at no charge.

6.  NO LIABILITY FOR CONSEQUENTIAL DAMAGES.   In no event shall STC or its suppliers be liable for any damages whatsoever (including, without limitation, lost profits or revenue, loss of use of software, loss of data, or costs of recreating lost data).  Some states do not allow the exclusion or limitation of consequential damages, so the above limitation may not apply to you.

7.  U.S. GOVERNMENT RESTRICTED RIGHTS.  The software and documentation are provided with RESTRICTED RIGHTS.  Use, duplication, or disclosure by the United States Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software – Restricted Rights at 48 CFR 52.227-19, as applicable.  Manufacturer is Service Technologies Corp./ P.O. Box 24756 / Winston-Salem, NC  27114-4756.

8.  GOVERNING LAWS.   This agreement shall be governed by, and interpreted in accordance with, the laws of the State of North Carolina.   
STC’s Windows System Manager - Overview

STC’s Windows System Manager is a simple, external Windows-based interface offering secure access to our Windows products.  System Admin handles setup & access for Users, Companies & Menus.  It operates from “outside” the DOS or Windows-based Accounting Package whose files it processes.  Key Benefits to users are as follows:

DOS-based Accounting System Users can put the powerful features of STC’s Pay-Ware & Utilities for Windows Programs to work with existing Systems.  No Accounting System upgrades are required!

Accessing STC Programs from “outside” the accounting package does not “add” to that system’s active User Count.  For User-intensive features such as Counter Sales terminals, this may reduce the user-license count (and maintenance fees) needed to run the system day to day.  Additional STC Users @$295 are significantly less costly.

Direct access from a smaller menu reduces the time & complexity needed to perform a specific task.  Users can “get in,” perform the desired activity and exit the job quickly without “clicking through” multiple menus

Network Users can use the STC System Manager to “repath” Pay-Ware payroll data files outside the accounting system drive.  This can allow “ironclad” network-level file access security for this sensitive data.

The System Manager Menu System is intuitively easy to use.  It is modeled after popular “Browser” formats with Program-Specific or Menu Group Categories shown down the left side and individual Menu Options on the right side.


[image: image57.png]Software License Agreement

?QJ Please readthe following License Agreement. Press the PAGE DOWN keyto see the
rest of the agreement

[MPORTANT SOFTWARE LICENSE AGREEMENT -- -
IREAD CAREFULLY BEFORE OPENING SOFTWARE

[This is & legal agreement between you (an individual or an entity) the end user, and Service
[Technalogies Corparation (STC). ffyau da not agree to the terms of this Agreement promptly
retum the unopened disk package and all accompanying writen materials o the place obtained
for eurefunct

1. GRANT OF LICENSE. This STC license agreement ("icense") permits youta use ne copy
lofthe STC software praduct ("software") on any single computer, provided the software is "in
luse" on only ane computer at any time. You mey have s many copies of the software in use as
lyou have licenses

[The software is "in use" in & computer when it s Ioaded into the temporary memory (ie. RAM) or
i installed into the permanent memary (e.g. Hard disk. or ather storage device) of that computes

Doyou acceptall the terms of the preceding License Agreement? ffyou chanse No, Setup will
close. To install STC A/R Report Bundle for Windows, you must accept this agreement

<Back Yes s




     

STC System Manager

STC’s Windows System Manager - Overview
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When installation is complete, the System Manager will install a new Pay-Ware option on the “Programs” section of the Windows “Start” Menu (see above).  It will also install (at user’s option) a Desktop Icon/Shortcut to the program.  The Program may be launched from either option.
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After being launched, the System Manager Login Window will appear requesting the User Name and Password.  Entering this information launches the “blue” STC System Manager shown above. 

System Configuration Requirements

The STC System Manager requires a computer with the following equipment:

Minimum Pentium 233 or higher CPU & 64Meg RAM - 8x CDROM drive 

Windows ’98 or later O/S 

Monitor capable of at least 800X600 display resolution.

Laser Printer is highly recommended.

Pre-Installation Checklist

1. If Installing this STC Windows Program to run ONLY from within the PFW by Best® Menu system (without installing the STC System Manager) STOP! See STC’s separate Installation Guide.

2. To install this STC Program including the STC Standalone System manager (for external program configuration & user access) follow the instructions in this guide. 

a. If access from BOTH PFW & STC System Menus is desired, the STC Program MUST be installed in the PFW Server & Client Directories.  PFW Administratative setup is required to properly handle Menu Item, User, & Company Access security under PFW.

b. If access is ONLY from the STC System Manager, the program may be installed on any drive/ directory.  Network Users must install the Program Files on a Network Drive.  Note that Client files must be installed on a local drive.  

Standalone installations MUST install Client files in a separate directory/folder from Program Files. 

3.  Due to the complexity of installation, it is recommended that an Authorized VAR or Consultant perform any STC Utility or Pay-Ware for Windows installation.

Installation Overview

STC Utilities for Windows installation procedure is a client/server installation. Any Windows-based programs should be closed and virus-detection programs disabled before installing.

Please read through the entire procedure before starting any Installation activities 

1. IF REQUIRED - Install Btrieve Workstation Edition. If your Workstation is not already configured with a Btrieve Workstation Engine or Pervasive 7 or .SQL Client, you MUST first install and configure the 6.15 Workstation Edition (6.15wse) included with this STC Windows product.   

2. Server/Program Files Installation – STC Utilities’ executable program files are installed from the CDROM to newly created subdirectory (X:\xxx\stc_util) on the network file server.  With PFW - Other PFW Resource/Menu files are updated and the STC Client Setup files are installed. 

3. Module User Setup – STC Utilities’ administrative functions (user access/security & Company Setups) are configured.  To run under PFW Menu, Menu access must be set up by the PFW System Administrator for existing and new users to ensure confidentiality.

4. The individual Client Workstation set-ups are made from the Server’s Client Files

 (Originating directory X:\xxx\stc_util\pwclient\setup.exe).

1. Btrieve 6.15  Workstation Edition Installation – IF REQUIRED

If your Workstation is not already configured with Platinum For Windows or a Btrieve Workstation Engine or Pervasive 7 or .SQL Client, you must first install and configure the 6.15 Workstation Edition (6.15wse) included with this STC Windows product.   You can easily determine this by reviewing the Windows Programs Menu (Start > Programs).

If either a “Btrieve Technologies Database” or a “Pervasive” Item appears on the Windows Programs Menu (see below) you may skip this Section and Go To Step 2 – Server Program File Installation.  Otherwise, continue with the following Procedure
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Begin this installation as follows – Be sure the CD is in the Drive

From the Windows Start Button, select Run and then Browse to the CD Drive.  Go to the “wse6.15” Folder.

Select the Setup Program in that folder so that the File Name/Path is X:\wse6.15\Setup.exe (below)
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Click OK and the installation program will begin
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The “normal” Install Shield windows will appear asking you to select the Installation location (Next) and the Name that will identify the program (Next).  We recommend just accepting the default information.
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After this information is entered/confirmed, clicking Next will start copying the program files to their locations.  When the ‘Finish” Window appears, click Finish (you may say “no” to skip the Read me File).  
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The following window should appear on your desktop.  If is doesn’t, you may launch it by clicking “Btrieve Technologies Database” on the Windows Program Menu.  Click on the Microkernal Setup Icon to properly configure the record manager.  Work from the top down through the list beginning with File Settings (see 2nd Box) and highlight each of the 6 parameters (in the 3rd Box) starting with “Open Files” and change it’s default values for the specified MKDE parameter values (125) shown below.  Don’t change any of the other settings.
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	 MKDE  Parameters

File Settings  (see 2nd box)  
    Open Files (see 3rd box)
    Handles

    Record Locks Per Client

    Index Balancing

    Create Files in Pre 6.x Format

     Logging of Selected Fields

Memory Resources (see 2nd box)
     Cache Allocation

Client System Transactions 

      Operation Bundle Limit

       Initiation Time Limit


	Value

Bottom Box

 125

 150

   75

 Off

 Off

 Off

 2048

 1000

10,000

Change Above Values Here




Do not adjust any settings besides those shown above.  Save the settings once all changes have been made.

This completes the Record Manager Setup.  You may now begin to install the Pay-Ware for Windows Programs (see next section). 

2.  Installation Procedure – Pay-Ware Network Server Files (Network Admin Rights required)

This step does not need to be run on the actual file server.  It is often best performed from a workstation.

· Identify the network Drive where Platinum system files are installed.

· Insert the STC CD-ROM into the drive and close it.  [Keep the Serial No. from the sleeve handy]

· Click the Start Menu & Select: “Run”.  Browse the CD Drive for the pay-ware folder 

	[image: image12.png]Lockn ISE =

DOCUMENTATION

payare
Sto_ul
wseB15

File pame: Open
Fies of ype: [Frograms B Cancel





	[image: image13.png]ki [ &) o EE

Flename:  [Setun

Open
Fies of ype: [Frograms B Cancel





	[image: image14.png]Run

‘Windows il open ot you.

Type the name of program, folder, o document, and

|

W il Sepaiate Hemoy Space

[

Cancel | Bowse.







· In the pay-ware folder select the set-up.exe program.  Click OK to Run it, and the routine will launch.

Note that this Upgrade Manual as well as the Pay-Ware for Windows 170 Page User Manual (in Word (.doc) and Acrobat (.pdf) formats are available in the DOCUMENTATION Folder on the CD

The following Installation Window will appear-Read the Information and Proceed to the Next window to review STC License Agreement.
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Hit “Yes” to “Accept” the terms of the Licensing Agreement and to proceed with the installation. 

(Note that you may go back to the previous Window or Exit the set up program at any time.)

This window is used to select which version of the program you want to install.  

If you have purchased a live version, there will be a sticker on the CD envelope with your serial number.

STC Programs Installation Procedure

	
	


Choosing the Standard installation, the above Window will appear requesting User Name, Company Information and Product Serial number.  Be careful to enter all the characters (including dashes) in the serial number accurately. You will not be able to proceed without a valid serial number.  Note that the Demo Version may be installed without a Serial No.  Hit “Next” button when information is entered.

The next Window will appear requesting the Drive/Directory locations where the program is to be installed.  Browse to change the default information.   Note, if this Program is to be accessed from the PFW Menu, it must be installed under the “Platinum System” folder on the server.   

Standalone users have the option to install into the existing Platinum folder or another location. If not installing under “Platinum,” we recommend that you install to an STCPROG Directory/Folder on the desired drive.
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Hit “Next” to confirm the Drive and directory information.  If this destination Folder does not exist, you will be prompted automatically to create it (see above).  Click Yes.  Another Window will then appear allowing you to verify all information entered thus far-if correct click Next and the file copying process will begin.

	When all files are copied to the Server this window will appear.  Hit the “Finish” button to complete the Server installation.  
You may remove the CD from the Drive when this process is complete.

There is generally no need to reboot as a result of this install.

	


3.  Installation Procedure – STC System Administrative Set up 

 Skip this step if the Program is not being run from the PFW System Menu 

User & User Group Access/Setups - Once the STC Utilities system files are installed on the server, the  System Administrator should log on and enable the new options for the eligible user groups.

Crystal Viewer - STC Programs run on the workstation and reports can be output to Crystal Reports’ viewer or to Windows Laser Printers.  To view any report again (without re-running it) it must be “saved” (to the Desktop is easiest) and opened in Crystal. Reports may also be printed to Windows’ printers after they are displayed in the Viewer.  .    

Printer Setups should be reviewed to verify they will work with the new options.  STC Programs print directly through Windows.  Platinum/PFW–defined printer setups are not used.  Since Crystal is a graphical. page-based output interface designed for Laser printers, printing reports to Dot-Matrix printers will be significantly slower than under PFW and some formatting may be lost.  

4. Installation Procedure – STC Program Client Workstation Set Up
After all Pay-ware server/system setup is done, the individual Workstation setups are run. From the appropriate Workstation, go to Start>Run and Browse to the Server drive’s Payware Client Set-up Folder (originating directory path X:\xxx\payware\pwclient\setup.exe).  [Directory “xxx” would be STCPROG for the example from the previous page.]

The installation procedure for the first 3 windows is the same as section 1 (above) except that the destination location folder on window 3 should be pointed to the workstation’s local Client Drive & Folder (generally c:\pfw for PFW users).  

For stand-alone/Local use, any Folder/Directory on the Local Workstation hard drive (We recommend C:\STCCLIENT) may be specified except for the directory where the Program files are installed (X:\STCPROG in the above example).  If the directory does not exist, the program will prompt you to automatically create it.


When “Next” is clicked, the routine will then prompt whether to install the STC System Manager – Click Yes.

[image: image17.png]Que:

Pay-Were for Windows can be run outside of the Platinum Systerm Manager. Would you like to
install the STC Systern Manager and Deskiop loon now?

|





Users are then prompted to specify the appropriate Windows Program Menu Group where the Program will be “launched.”  Specifying the default will add a PFW Group and Menu Item.  This means that when Windows Start>Programs are clicked there will be a “Pay-Ware” option on that list of Programs.
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When Next is clicked, the verification window allows you to confirm the installation path for the Pay-ware client files.
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When Next is clicked, the installation will begin copying files from the “system/programs” folder down to the “client folder on the local drive.

Once the files have been copied to the local PFW drive, click “Finish” to complete the installation.   After all Client Workstations that will be running Pay-Ware are set up, software installation is complete.

5. Verify Installation
The final installation step is to inspect the Windows Programs Menu and the Desktop for the new STC Program & Icon.  Each of these should be double clicked to verify that it launches the Login Window shown in the Overview section of this document.  If so, the installation has been successfully completed.   

You must repeat this procedure for all Workstations accessing STC Programs.

6. Setup Procedure – STC System Manager Configuration-First Time Access

     PC Administrator or Accounting Supervisory Personnel should perform these steps

This is the final step before an STC Program can be run from the STC System Manager.

Launch the STC System Manager by Double clicking the STC Program Menu item or the STC Desktop Icon to bring up the Login Window.  Someone with responsibility for PC Implementation/Supervisory responsibility next logs in as “Admin” with the Password “MASTER” (both of these are case-sensitive) to access the program configuration options.  Note that the Admin User CANNOT do any routine processing.  It is only used to Setup User Group Menu Item Security, Users & Companies.
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STC Login Window

Once the STC System Manager loads, access Administrative Option by clicking “Admin” just below the blue Title Bar.  The first item to be configured is “User Group Setup.”   Note that no menu items may appear yet.
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STC System Manager Menu-Administrative Options

STC System Manager Configuration - (continued)

 User Group Setup controls Menu Security allowing Administrators to customize Processing Menus by User Group.  The Menu Items visible to each User and their ability to process (or merely view the data available) on a Menu Item is determined by the User Group to which that User is assigned.  The “Default” user Group comes with the program.  The easiest way to load the Configuration Window is by double clicking the “Find Record” Lookup button (this is similar to the ALT I function in DOS) & then clicking on Default Group in the lookup window.  To change Menu Item security, you may alter the Default Group setup or create new “Payroll” Group(s).
[image: image22.png]ser Group Setup
Eile Edit View Help

0|

Adrmin

E

| #] ] «| > [p1] [company Key BNE

=18l x]

Group Securi

[_[CIx]

| x| o]
Key o |Description S
1. Group Info. L
PAYROLL _|PAYROLL DATA ENTRY ONLY
EopD DEFAULT
Group Name Default Group
X 5
SysiD Menu Description Option Description Read | Wite

T | HR [File Lisings 5|
2 HR Department Listing I I -
) Savings Bond Denominations [ [
| R (Attendance Codes Listing [ [
5| R Posiion Codes Listing [ [
6| R Ethnic Codes Listing [ [
7| R EEO Class Listing [ [
E | R Warkman's Comp Cade Listing [ [
G | R Termination Reasans Listing [ [
0| HR [Activity Types Listing [ [
) [Activity Status Listing [ [
12| HR Employee Master Listing 2 2
13| HR__|File Maintenance
) Department [ [
5| HR Position Codes [ [ [l





User Group Setup Window

After the window builds, the list of all Menu Items will appear with a Read & Write Column of checkboxes.  Each Menu Item that is checked “Write” will appear to every User assigned to the “Default” User Group.  They will be able to fully process all these items.   Menu Items checked “Read” will allow the User access to the information available on that Menu Item, but the user will not be allowed to change or process any of its data.  Items that are not checked will not appear at all on the User Menu.

Once the Default Group’s Menu is checked off, the change to the record must be “saved” by clicking the File>Save or the Diskette Icon (same as most windows programs),

	
Open New Record
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“Cloning” a User Group (or any record) is quickly done by selecting an existing record (Group), which is setup similarly to the record to be added.  Once the record is loaded, click the “Edit>Set As Default” Menu options and then the “New Record” (leftmost) Button.  Change the ID, Name and revise any other desired data.   Then “save” the newly named record.

STC System Manager Configuration - (continued)

Company Setup (accessed by clicking the Admin Menu) is the second Setup item to be configured.  There are no defaults setup for this menu item.  New processing companies may be setup from “scratch” or the STC System Manager can be configured to access data from an existing Accounting System.  The window allows a Company Key & Company Name to be setup in fields 1 & 2.  These can be the same or different than the Key(s) & Name(s) specified for the same data in the Accounting System.   The data fields, which get processed, depend entirely on the data paths entered in Fields 3 & 4.  To access data for an existing Platinum Company (OLDCO for example) you just set the Company data path in Field 3 to that location.  This feature can allow sensitive payroll data to be moved to a separate Network drive/directory for security reasons.

Lookups and record “cloning” work just like those in User Group Setup.   
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Company Setup Window

User Setup – After User Groups and Companies have been setup, Users may be assigned to them.  Clicking on the Admin Menu’s User Setup option loads the following configuration window. 
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User Setup Window

User IDs are entered in Field 1 and Password in Field 2 (leaving blank will allow user access without a password (hit Enter).  The user is assigned to the desired User Security Group and Processing Companies (see above) in Fields 3 & 4.  Note the “Find Record lookup on the “User Key” field at the top of the window allows quick retrieval of all users’ configuration.   Lookups and record “cloning” work as previously described.

When all Companies & Users have been setup, STC System Manager configuration is complete.       

With all Administrative Setup complete, Users may Login, select a Company and get familiar with Pay-Ware’s processing basics.

Remember the following:

DO NOT APPLY ANY PATCHES TO THIS PROGRAM - IT CONTAINS ALL PATCHES AND UPDATES THROUGH OCT 1, 2001

You must be logged in as a valid User and select a valid company to process anything in Pay-Ware for Windows.  We ship with only USER1 enabled.  Current PFD Users with other ID’s other than USER1 will have to be setup.  

Pay-Ware for Windows prints only through printers setup in Windows  [PFD Printer setups are not recognized].  If you cannot print properly from it, your windows printer setups are nonstandard and must be setup.  Laser-type printers are strongly recommended - Dot Matrix printers are not fully supported.

If you are upgrading your Platinum to a newer version in conjunction with this Pay-Ware Installation -be sure to change Pay-Ware’s GL Interface for all companies (System Configuration>Application Setup>Interfaces).

Note: You will not be able to access any Pay-Ware for Windows Menu Options for existing “live” Companies until your DOS Data files are upgraded - you will receive a message to upgrade when you click on any Menu Item in those companies.

You may view the Windows & Demo data referenced in this section by changing into the GLSDEM-It’s a Dog’s World Company

If you wish to run this Data Conversion now so that you can view the windows for existing company data - go to page 21 of this Manual and follow the Conversion instructions.

Remember to verify your real data for accuracy.   

STC Programs – User Processing Basics - File Maintenance/Data Entry

Windows Processing Basics
STC Programs processing windows are similar to those of most Windows Programs.  There is the familiar Blue Title Bar at the top Identifying the Window and its Max/Min/Max/Close boxes. 

The basic Menu Row for File, Edit, View & Help functions is also familiar and many tasks associated with those operations (such as Save, Delete, Cut, Paste, etc.) are similar to most Windows-based programs. 

  Note that “right clicking” the mouse will launch a Cut, Copy, Paste Menu (found under the Edit Option).  
Other tasks are more program specific.  For example the File Menu contains all activities associated with accessing a record and moving through the database (Get First/Last/Next/Previous Record & Find, Save or Delete Record). 

The row of “Operator Buttons below the Menu Row is more unique to STC Products.  They largely provide a shortcut to the actions associated with the Menu Items above. But they should be familiar to any user of a Windows-based Systems.  These click able buttons replicate the Platinum DOS version “Alt+” Key commands (Alt+A ,C, D, F, I, L, N for “add”, “change”, “delete”, “first”, “inquire”, “last”, “next” 

These “Buttons” do the following (Right to Left).  

New Record 
       Erase/Delete Record


         Save Record    Get 1st or Previous Record





   

Get Next or Last Record






 


   Find Existing Record Button (Similar to Alt+I)
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The Arrows & Double arrows allow users to “Step through” the available set of records frontward or backwards.  The Find Record Lookup Button allows a quick way to find a specific record without stepping through them via the Arrows.  Almost every field within a maintenance, entry, or parameter window has an associated lookup.

“Cloning” a record, allows users to quickly add a new item to the database, which is very similar to an existing item.  This is quickly done by loading an existing record, (which shares many parameters with the “new” one). Once the record is loaded, click the “Edit>Set As Default” Menu options and then the “New Record” Button.  Change the ID, Name and revise any other desired data.   Then “save” the newly named record.

STC Programs – User Processing Basics - Lookups

Lookups contain the available information for entry in the field.  Data to be entered in the field is selected from the lookup dialog box.  A Field’s lookup is almost always displayed by choosing/clicking the lookup button or pressing F9.   With certain lookups, you can scroll through the available lookup information.

	A.   Table or Field Lookups

These lookups appear in a Window as a “Magnifying Glass” Icon to the right side of a field.

Clicking the Icon will launch a small mult-Iine lookup window from which available information may be selected.  

     Table Lookups (“Find Record”) replace the PFD   

     Alt-I Inquiry and appear against a Yellow

     background (generally found at the top of a  

     parameter window)  & will show all available data   

     fields for a given record when it is clicked.  [This 

     will populate all data fields on the window].

     Field Lookups replace the PFD Alt-Z Inquiry &  

     show against a gray background and return only 

      the data to populate that data field 

 Include List lookups appear as a “Down Arrow” to the right of a field.  All available data options “drop down” when the arrow is clicked.
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	Calendar Lookups appear as desk calendar Icon on Date-Related fields and launch a calendar with the current date


STC Programs – User Processing Basics - Running Reports & Listings

Reports & Listings are a key component of your STC Program.  This Program generates all its reports using Seagate® Software’s popular Crystal® Reports program.  Unless specified otherwise on the “Routing” Tab of a Report’s Setup Parameters, the report will automatically be displayed On-Screen in the Crystal Viewer when is completed.  From the Viewer, the report may be printed to Windows Printer, printed to a file or its data exported to a Spreadsheet.   Any report’s “Routing” parameters may specify output directly to a printer.  In this case, the report will not appear on-screen in the viewer. 

Note that Crystal is a graphical, page-based printing program intended for Laser-type printers.  While it generally will output to Dot-matrix printers, Users may encounter long report printing times and formatting glitches.  We strongly recommend using Laser-type printers if at all possible. 

It is easy to define and save standard report parameters against which Reports or Listings are routinely run.  Any Report (or Listing) which has had a parameter configuration “saved” will appear in a View List (below).  

In reports where no parameters have been saved, the View List will be empty.  

A “pre-saved” report can quickly be run by highlighting it and 1) clicking its Name in the box or 2) clicking the Process button below the list.  If the pre-saved format includes data fields that need to be filled in (for a range of Dates, for example) the Parameter setup window will automatically load and the cursor will stop in the first Field where an entry is needed.  This field will show a “Pencil” icon to the right. An entry must be made in all empty fields (clearing every Icon) before the report will process.

Note that pre-saved parameters include the output location for the report (e.g. a specific Windows printer), 

Setup Parameters for any saved report may then be viewed and Modified by clicking the Edit Button.  If changes are made, the modified configuration may then be resaved under the old name (or saved under a new name-which creates an additional report on the View List) by clicking the Save Button.  The Report is removed from the View List via the Delete Button.
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STC Programs – User Processing Basics - Running Reports & Listings (cont’d)

Choosing the New or Edit buttons will load the Report Parameter Setup Window where Reports are defined and (optionally) saved.  

Clicking “New” will load a “blank” parameter Setup window (no data entries in any field).

Clicking “Edit” on a highlighted report in the View List will load all its setup parameters.

The typical Setup procedure goes as follows:

Parameters Tab

1. Sort Order for the report is selected in the top Field

2. One or more Ranges of available Data items to be included in the Report are specified.

3. Often a Range of Dates parameter is specified for the Report

Output Format (Detail, Summary, inclusion of Totals or Page-breaks, etc.) items are specified.

4. Note the “Pencil” Icon (below left) setup on the first Date Field.  It is used when report parameters are setup to “require” an entry in specific field.   The “Pencil may be removed from a field by 

	Clicking the Pencil Icon (top of window) while the cursor is parked on a field and “saving” that Report Parameter will prompt for an entry in that field next time the saved Report is processed.  Entering valid data and hitting the <Enter> Key clears the “placeholder” and launches the report.  Clicking the Pencil Icon again will remove the placeholder/prompt.
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Tab 1- Parameters
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Tab 2 - Routing


Routing Tab (see above right) specifies where the report will be “sent”.  All reports are defaulted to the Crystal Reports Viewer but the setup may be sent directly to any Windows printer.  You may require this Tab to appear before any saved report is processed by checking the “Show this Tab before processing” box at the bottom.  This makes it simple for the user to route a given report to the desired printer or to the viewer. 

Remember that Dot-Matrix Printers are not optimizable for Crystal output.

Pay-Ware Version 4.9 Enhancements vs DOS

	Introduction 


	Welcome to Pay-Ware( for Windows version 4.9. 

This release of Pay-Ware for Windows is compatible with versions 4.6 or Higher of Epicor’s( Platinum( for DOS.  DO NOT APPLY ANY PATCHES TO THIS PROGRAM – IT CONTAINS ALL PATCHES & UPDATES THROUGH OCT 1, 2001



	About this guide
	This guide covers the following topics:

· Key User Changes & Enhancements Summary

· New Features & Enhancements Detail

· Pay-Ware Crystal Reports Reference

· Report Format Troubleshooting

· Data File Conversion

· Cash Account Determination

· Next Check Number

· General Ledger Interface

· DRA Codes

· CRViewer Failed to Self-Register

· Comcat.dll failed to self-register

· Error 163 when updating files

· Dr. Watson error

· Record Manager Error-Status12-File not found




Data File Conversion 

You must upgrade you existing Pay-Ware Data files before running Version 4.9.

· Make a backup of all PBxxxxx Files in the following Directories before running this conversion

· The “Company Key” Directory (i.e. “Platinum System”\CoName\PBxxxxx)

· The “Data” directory under Platinum (i.e. “Platinum System”\Data\PBxxxxx)

· Delete or Rename any  *.sav, .new  or *.old  files in the Company Directory

· Go to Pay-Ware’s Utilities Menu and select the  “Convert to Version” 4.9” menu item. A View List window will appear.  Click New to bring up the Routing Screen.  Click  “Process” to launch the conversion

[image: image31.png]Convert to Vers

n 4.9 [[o[x]

ViewList

Edi)

el




 [image: image32.png]Convert to Version 4.9

oo | (G Bouting [ =

- Subit o gueue:

[Fun Lacaly

Distibution__|

~Sendrestltsto.

© 1. Piter [Generic / TextOrly

& 2 Copstal Viewer

[~ Options

I~ Show this tab (Routing) before processing

New Process Close Save Help





· It should run through to completion.  The Crystal report will show 9 files as having been successfully converted if everything has run correctly.  Inspect the data via File Maintenance – At least Run a Payroll Journal & Employee Master Listing and check GL Account-related fields/lookups.  Upon verification of the converted data, the backups may be deleted.

Key  Enhancements - Summary:
Additional documentation on significant additional features follows this section.  

· Pay-Ware will no longer use Platinum Printer Setups.  Only Windows( Printer Menu options will appear.  Printers configured under Payware DOS will not be displayed.  Dot-Matrix Printers will not perform optimally with Crystal Reports.  We strongly recommend use of Laser-type printers
· Crystal Reports - All “Standard” Edits & Reports have been converted into Crystal Reports.  After they are launched, reports will automatically appear in the onscreen Crystal Viewer.  From there, the report (or data fields) may be refreshed, printed or exported.  Export options may send the formatted report to a file (for later viewing) or the data to a spreadsheet application for additional processing.

· Predefined Report Parameters from DOS are not used.  Windows list of “standard.” predefined report options has been significantly expanded.  Users with important customized DOS reports should “print screen” setups to ensure they can be re-entered after the conversion. 
· Recap Options have been added to the Payroll Register Reports (Pay Period & History).  These can provide a single total for the selected time period by department without printing individual pay period detail.  Select Option 3 for the “Subtotal/Break On” Fields.

· Single Window Access Technology (S.W.A.T.) provides a complete view of all employee information (including Activities, History, Balances, Timecards, Most recent check & Employer Benefit Plans) from an employee’s master record (details in the next section). 

The “Hot Print” button on this Window allows fast, yet secure, printouts of any user-selected employee information category without “jumping out” to another Window.

· “Hot Print” buttons (similar to the one above) have also been enabled for all File Maintenance Windows.  A “Printer” button will appear on the toolbar for those maintenance windows where its File Listing has at least one “View List” report defined.  This generates the listing without leaving the file maintenance window.

· Computed Edit by Department processing is now available to allow easy generation of Payrolls for one or more Departments.

· SDI/SUI Tax Processing logic has been modified to process SDI taxes on each Employee’s SUI-designated State.  This is a change from the previous processing logic, which based SDI the Employee’s designated withholding State.

· Check Reprint Utility – handles all accounting transactions associated with replacement of an exsisting check (previously it merely added a notation to the check register for a new check without affecting previously posted transaction data).  It now posts offsetting payroll register transactions to the original check number/date and posts a new set with the updated check date and number.  The reprint updates only the Bank Book transaction.
· NOTE: New GL Records or ACH File transactions are NOT created.  To affect these     transactions, old checks must be voided and a new edit/print/post [manual or computed] run.

· Enhanced PFW Interfaces to A/P & Project Costing modules 

- Auto-deposit checks may be processed via A/P vouchers/checks.allowing more control   over payment timing and easy VOIDING of     

  errant checks.

- Payroll-related expenses may be interfaced to Project Cost by Units only, Dollars only or Both.
New Features & Enhancements – Details

	
	

	Reports Menu

-Grouping Change

-New Standard Reports

-Employee 

  Status Reports
	Pay-Ware’s Reports Sub Menu is shown below.  The “clustering” of similar report types can be seen.  There are 4  “clusters “ of reports plus Quarterly Reports and Workers Comp Report.  These “clusters are Employee Reports, Interface Reports, Current Pay Period (PP) Reports and Payroll (History) Reports.  

After this upgrade is installed-many reports will display additional “standard” report options.  Users who have defined important customized reports should hard copy document setups to ensure they can be reentered (if necessary) after the conversion. 

The Employee Status Menu Option has been added with predefined HR-type reports being requested by the user base.  Note that these same reports are available from the Employee Master Listing (found on the File Listings submenu)

Available Sort Orders on the Employee Status reports include EE Key, EE Name, Department, SSN, Division/Department and (in limited reports) User-Defined. 

      Tab 1 specifies the desired range of (Employees, Departments, etc.) to be reported.  

      Tab 2 applies Status & Date-related filters to the data range selected on Tab 1.

               Employee Status Filters include (Active Terminated, Leave or All)

               Date Filters include (Activity, Birth, Hire, Review, Termination)

      Tab 3 selects the Employee data categories to be reported (as follows).

               Personal, Pay, DRA, Dependent, Job, Activities, Emergency Info, Accident, Wages

               Current information &/or Historical (Change Log) Information may be included



	EE Status Reports


	Some of these predefined reports are Date period-based.  They return user-selected information based on “date field” values  (Birth, Hire, Review and Termination) entered on their employee record.  They find employees having dates within the selected ranges and provide a report.  This is shown below.
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To obtain Date-dependent information, Question Marks may be selectively entered in Date fields.  For example, to get a list of Monthly birthdays for June, the desired Birth date period would be keyed as 06/??/??.  This will return selected data for all employees with a birth month of 06 regardless of the values in the day or year portions of the date field.  



	Reports

Crystal® Conversion
	All “Standard” Edits & Reports have been converted into Crystal Reports.  After they are launched, reports will automatically appear in the onscreen Crystal Viewer.  From there, the report (or data fields) may be refreshed, printed or exported.  Export options may send the formatted report to a file (for later viewing) or the data to a spreadsheet application for additional processing.  See below notes for customization.

After they are launched, reports will automatically appear in the onscreen Crystal Viewer.  From there (see below) the report (or data fields) may be refreshed, printed or exported. Customization of the predefined reports is also easily accomplished. 

 Crystal Viewer Buttons for Refresh, Print, Export (depressed).
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	Reports

Crystal® Conversion

Continued

A Crystal Register is shown at right
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	Crystal® Reports

Printing & Customization Notes


	Pay-Ware’s predefined Crystal reports are stored in the Crrep folder in the Payware folder resident in the “Platinum” folder on the Server (complete directory path is x:\platinum payware/crrep).  Once any customization to a predefined report is made, the modified report should be resaved in the Custom folder (also under Payware).  This folder will not be overwritten by any future updates and Crystal will check this folder for a customized report before calling the “standard” report layout from the Crrep folder.

A complete library of Crystal report formats with Report Name & Key is appended to this documentation and included on the CD in the Documentation Folder on an excel spreadsheet named crystalnos.xls.  
Special Note if you use a Dot Matrix/Trackfeed Printer.

Crystal is a graphical, page-based printing program optimized for laser printers.  You can print to a dot matrix printer successfully with it. But we recommend you convert to laser printing for speed & efficiency. 



	Crystal Check Printing

Issues/Options
	In addition to the established Check & Direct Deposit Advice printing options, Checks and/or Advices may now be output to Crystal.  The Crystal format offers total control over the appearance and format of your paychecks.  Check Printing settings are modified via the Application Setup option on the System Configuration Submenu.  Advice settings are changed in Direct Deposit Setup (same submenu)  We strongly recommend you test out the Crystal check setups and change over. The switch should be transparent if you are now using “standard” check forms and a standard 66-line/pg laser printer.
Dot Matrix Printer Users – please note the following:  Internal testing on an Okidata Microline 321 with IBM Proprinter emulation shows that outputting directly to the printer will most likely run the printer in “utility” (draft) mode, while printing from the crystal viewer printed in “letter quality” mode. There is a Crystal 11 Inch Dot Matrix Check option included to make the transition. 

Direct Deposit Users don’t forget to change your Advice Printing to Crystal Format [System Configuration>Direct Deposit Setup] when you change your checks to Crystal  – You will receive an Error when you print them if these are set differently.  

Error Message while printing checks – file 038A

	
	

	Report Options

    Register Recaps

   User-Defined Sorts


	A Recap Option is available for all Payroll Register Reports (PP & History Versions). This greatly reduces the report size where only Register Totals are desired.  It provides a single total for the selected time period by employee or department without individual pay period detail.  Select Option 3 for the “Subtotal/Break On” Fields.

 Major Reports also have enabled “User-defined” Options in the “Sort by” box.



	Employee Master

Single Window Access Technology

(S.W.A.T.)


	One of Pay-Ware 4.9’s significant improvements is its Single Window Access.  From the Employee Master Window, the user may now view all employee information.  New buttons on the toolbar make each Employee’s History, Current Year Attendance & Pay Balances just a mouse click away.  The Employee’s information can then be printed to hard copy via use of the “Print Button” to remotely run any Employee Master Listings that are setup.  Note that the printer button will not appear unless there is a saved report on the View List in File Listings.

                                        EE History    Attnd Bal    Pay Balances     Print Listing        
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In addition, to the above information, the following data is now displayed on Employee Records

· Tab 2 – Most Recent Check Information

· Tab 6 – Benefits - Both Employer & Employee Paid

· Tab 7 – Any Time Cards currently entered for Computed Payroll  


	Generate 

Auto-Deposit Check via A/P


	Auto-deposit checks may be now be processed via A/P vouchers/checks. Generating Payroll tax payment checks via A/P allows more control over payment timing, cross-company consolidation of Autodeposits and easy VOIDING of errant checks.
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Autodeposits are enabled via the System Configuration submenu on the Application Setup window for Federal (see above) & also on the State Unemployment Information window. 



	Computed Edit 

By Department
	You can now run the Computed Edit by Department Range as well as by Employee Range.  This greatly simplifies running a “special” payroll for a specific Department.  It is activated via the Computed Edit Report Setup Window (below).
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	PFW Project Cost

Interface
	As enabled on the 4.8a release, labor units, labor dollars or both may be interfaced to PFW Project Cost.  This can be set for each Attendance Code on its File Maintenance Window.

 

	STC Demo Options

-Time & Billing
	For easy demonstration purposes, the STC Time & Billing Interface and appropriate Demo Data have been set up in the GLSDEM (Demonstration Inc.) Company.  An Overview of this feature is available in this documentation. 


Report Format Troubleshooting Note:

The report parameter has been initialized with our standard reports.  You will need to reenter any customized reports you had in DOS.   If you get an error message when running any presaved report, DELETE that report from the View List, reset the desired Parameters and save it.

Cash Account Determination

The cash account is determined when the edit is performed for either manual or computed checks.  Check your saved report formats.  The default on the new option comes from the account selected in GL Tax Accounts from the System Configuration menu.
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Next Check Number

The next check number is saved on the Automatic Numbering Screen second tab.  From the View List  In Print Checks on new reports, the number is pulled from the Automatic Numbering Screen.  If you save parameters, you want to put an @ sign in that field so it will be refreshed for the check run.  If you need to modify the number at that time, you may key in the next check number to be used for that check run.
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Manual checks work in a similar manner.  Checks only print for transactions with nothing in the check number on the entry screen.  If the @ sign is entered in the Next Check Number box, the number will default from the Automatic Numbering Screen.  This number will be overridden if a check number is keyed in this box.
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DRA Codes

In the DOS version, the flags for each code are set up on each employee.  The Windows version uses the flags from the default record.   Verify that these match up. 
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General Ledger Interface

The General Ledger Interface is changed on the Application Setup second tab.  Choose none, PFD or PFW.  
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	Pay-Ware Crystal Reports Reference


	

	
	

	Program #
	 MENU OPTION
	Crystal Report
	Shared with Programs
	Files Used
	

	
	
	
	
	
	

	157
	Activity Status Listing
	157
	153, 154, 156, 158
	PBDFLTx
	

	158
	Activity Types Listing
	157
	153, 154, 156
	PBDFLTx
	

	151
	Attendance Codes Listing
	151
	
	PBDFLTA
	

	123
	Bank Book Interface Listing
	123
	
	PRBB
	

	72
	Cafeteria Plan (DRA) Defaults Listing
	72
	
	PBDFLTC
	

	34
	Computed Edit
	34
	22
	PBEMPMST, PBHSTTRN
	

	73
	Department Listing
	73
	
	PBDEPT
	

	121
	DRA Register
	162
	24, 36, 40,168,203,206
	PBEMPMST, PBHSTTRN, PBHSTDRA
	

	154
	EEO Class Listing
	157
	153,156,158
	PBDFLTx
	

	71
	Employee Master Listing
	71
	
	PBEMPMST, PWLOG, PBDFLTx
	

	54
	Employee Payroll Journal
	54
	
	PBEMPMST, PBEMPBAL
	

	56
	Employee Salary Statistics
	56
	
	PBEMPMST, PWLOG
	

	71
	Employee Status Report
	71
	
	PBEMPMST, PWLOG, PBDFLTx
	

	69
	Employer Benefits Defaults Listing
	270
	
	PBDFLTC
	

	153
	Ethnic Codes Listing
	157
	154,156,158
	PBDFLTx
	

	251
	Generate Prenotes
	167
	
	PBHSTDD, PBEMPMST, PBHSTTRN
	

	941
	Government Reports--941
	941
	
	PWLOG
	

	53
	Interface Distribution to General Ledger
	53
	25,37,204
	PBDIST, PBEMPMST, NLCHART
	

	
	Interface STC Project Cost to A/R
	810
	
	ARCUST, PWLOG
	

	33
	List time cards
	33
	75,122
	PBEMPMST, PFDFLTA, PBTC
	

	81
	Load time cards
	81
	
	PBEMPMST, PFDFLTA, PBTC
	

	22
	Manual Payroll Edit
	34
	
	PBEMPMST, PBHSTTRN
	

	111
	Pay Rate Tables Listing
	111
	
	PBDFLTR
	

	163
	Payroll Check Register History Report
	163
	202
	PBEMPMST, PBHSTTRN
	

	167
	Payroll Direct Deposit History Report
	167
	205
	PBHSTDD, PBEMPMST, PBHSTTRN
	

	162
	Payroll DRA Detail Report
	162
	24,36,40,121,168,203,206
	PBEMPMST, PBHSTTRN, PBHSTDRA
	

	168
	Payroll Employer Expense History Report
	162
	24,36,40,121,203,206
	PBEMPMST, PBHSTTRN, PBHSTDRA
	

	161
	Payroll Register History Report
	161
	23,35,201
	PBEMPMST, PBHSTTRN
	

	152
	Position Codes Listing
	152
	
	PBDFLTP
	

	202
	PP Check Register
	163
	
	PBEMPMST, PBHSTTRN
	

	205
	PP Direct Deposit Detail Report
	167
	
	PBHSTDD, PBEMPMST, PBHSTTRN
	

	203
	PP DRA Detail
	162
	24,36,40,121,168,206
	PBEMPMST, PBHSTTRN, PBHSTDRA
	

	206
	PP Employer Expense Detail
	162
	24,36,40,121,168,203
	PBEMPMST, PBHSTTRN, PBHSTDRA
	

	204
	PP GL Distribution Detail Report
	53
	25,37
	PBDIST, PBEMPMST, NLCHART
	

	201
	PP Payroll Register Report
	161
	23,35
	PBEMPMST, PBHSTTRN
	

	36
	Preliminary D/R/A Detail
	162
	24,40,121,168,203,206
	PBEMPMST, PBHSTTRN, PBHSTDRA
	

	40
	Preliminary Employer Expenses
	162
	24,36,121,168,203,206
	PBEMPMST, PBHSTTRN, PBHSTDRA
	

	37
	Preliminary GL detail
	53
	25,204
	PBDIST, PBEMPMST, NLCHART
	

	24
	Preliminary Manual D/R/A Detail
	162
	36,40,121,168,203,206
	PBEMPMST, PBHSTTRN, PBHSTDRA
	

	25
	Preliminary Manual GL Detail
	53
	37,204
	PBDIST, PBEMPMST, NLCHART
	

	23
	Preliminary Manual Payroll Register
	161
	35,201
	PBEMPMST, PBHSTTRN
	

	35
	Preliminary Payroll Register
	161
	23,201
	PBEMPMST, PBHSTTRN
	

	38A
	Print ACH advice
	38A, 38AD
	with -DM for dot matrix printers
	PBEMPMST, PBHSTTRN, PBEMPBAL, 

PBHSTATT, PFDFLT, PBATTBAL
	

	38
	Print Checks
	38C, 38CD
	with -DM for dot matrix printers
	PBEMPMST, PBHSTTRN, PBEMPBAL, 

PBHSTATT, PFDFLT, PBATTBAL


	

	26
	Print Manual Checks
	38C, 38CD
	with -DM for dot matrix printers
	PBEMPMST, PBHSTTRN, PBEMPBAL, 

PBHSTATT, PFDFLT, PBATTBAL
	

	87
	Reprint Direct Deposit Advice
	38A, 38AD
	with -DM for dot matrix printers
	PBEMPMST, PBHSTTRN, PBEMPBAL, 

PBHSTATT, PFDFLT, PBATTBAL


	

	82
	Reprint Pay checks
	38C, 38CD
	with -DM for dot matrix printers
	PBEMPMST, PBHSTTRN, PBEMPBAL, 

PBHSTATT, PFDFLT, PBATTBAL
	

	
	Savings Bond Denominations
	76
	
	PBDFLTD
	

	74
	Savings Bonds Listing
	74
	
	PBDFLTB
	

	604
	Scheduled Classes
	604
	
	PBDFLTS, PFDFLTF
	

	605
	Scheduled Employee Activities
	605
	
	PFEMPACT, PFEMPMST, PBDFLTS, 

PFFLTQ, FBDFLTF
	

	
	State Unemployment Information Listing
	112
	
	PBDFLTU
	

	
	STC Job Levels Listing
	818
	
	PBLVLUNT
	

	
	STC Job Master Listing
	815
	
	PBJOBMST, PBJCRATE
	

	156
	Termination Reasons Listing
	157
	153,154,158
	PBDFLTx
	

	122
	Time Card History Listing
	33
	75
	PBEMPTMST, PFDFLTA, PBTC
	

	75
	Time Card Listing
	33
	122
	PBEMPTMST, PFDFLTA, PBTC
	

	83
	Time Sheet
	83
	
	PBEMPMST
	

	192
	Workman's Comp Wages
	192
	
	PWLOG, PBEMPMST, PFDFLTW
	

	155
	Workman's Compensation Code Listing
	155
	
	PBDFLTW
	


TROUBLESHOOTING Common Installation Issues

CRVIEWER Failed to Self-Register

The Crystal Viewer is dependent on certain files matching up.  They vary by operating system.  The newer windows releases install without incident. 

 If you get an error on a Windows 95 workstation, copy the files from the server’s  platinum\payware\win95 directory to the c:\windows\system directory and reinstall the Pay-Ware client.

If you get an error on a Windows 200 or NT4 workstation, copy the files from the server’s platinum\payware\winnt directory to the c:\winnt\system32 directory and reinstall the Pay-Ware client.

Comcat.dll failed to self-register

The solution varies depending on operating system.  On a Windows 95 or 98 workstation, rename the existing comcat .dll in the c:\windows\system directory to comcat.old.  On a Windows NT workstation, rename the existing file in the c:\winnt\system32 directory to comcat.old.  In either case, then rerun the Pay-Ware client.  The correct version of Comcat.dll will be copied in and registered.

(Comcat.dll – 22kb – 6-11-1999).

ACBTRV32.OCX failed to self-register

This message is caused by a dependency issue with file WBTRV32.DLL which goes in the windows\system or winnt\system32 directory depending on the Windows version being run.  It should be a 42K file.  The correct version should be in the pvsw\bin directory on each workstation and can just be copied into the correct directory.   

Error 163 updating files

Pay-Ware requires the environmental variable of cobsw to be set to –f.  

In the older operating systems that utilize autoexec.bat during bootup, edit this file and insert this statement first in that file:


Set cobsw=-f

On Windows 2000 or NT4 this is entered from the Control Panel, System, Advanced, Environment, New—then in the Variable box enter cobsw and in the Value box enter -f

You will need to reboot the workstation for this change to take effect.

Dr. Watson Errors for Webcheck or Loadwc

Go to C:\WinNT\System32 and check Webcheck.dll file should be 269kb dated 8-16-1999 – if you do not have this version you can copy newer version in and reboot and error should go away.  

This is a Microsoft file and should be updated with Version 5 of Internet Explorer.

Record Manager Error – Status 12 File Not Found – File may need to be initialized.

If the installation fails to auto-initialize any new data files-you may see the above error message.

Files are initialized from the Utilities Menu - select Initialize Data Files.  Click Yes ONCE when the below left Warning appears.  Enter Yes and the file list appears-then scroll down to the appropriate file and highlight it.  The below right warning will appear confirming the file name-click Yes to initialize that data file.
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